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A Few Words

[ABOUT THIS KiT

The overall goal of this kit is fun. Beyond this, the aim is to get
you comfortable using a wide range of electronic components
through small, simple and easy circuits. The focus is to get each
circuit working then giving you the tools to figure out why. If you

encounter any problems, want to ask a question, or would like to
\know more about any part, extra help is only an e-mail away help@oomlout.com. J

(" ABOUT OPEN SOURCE HARDWARE

All of the projects at SparkFun and .:oomlout:. are open source. What does this mean? It means
everything involved in making this kit, be it this guide, 3D models, or code is available for free
download. But it goes further, you're also free to reproduce and modify any of this material, then
distribute it for yourself. The catch? Quite simple, it is released under a Creative Commons (By -
Share Alike) license. This means you must credit .:oomlout:. in your design and share your
developments in a similar manner. Why? We grew up learning and playing with open source
software and the experience was good fun, we think it would be lovely if a similar experience was
possible with physical things.

More details on the Creative Commons CC (By - Share Alike) License can be found at

\_ http://ardx.org/CCLI -/

J

(" ABOUT .: OOMLOUT :.

We're a plucky little design company focusing on producing
“delightfully fun open source products”

To check out what we are up to

\_ http://www.oomlout.com Y,

(" ABOUT SPARKFUN )
SparkFun is an energetic young company seeking to make electronics fun, accessible,
and approachable to everyone - from kids in elementary school to PhD-toting engineers.
http:/ /www.sparkfun.com/

- /

(" ABOUT PROBLEMS )
We strive to deliver the highest level of quality in each and every thing we produce. If you ever find an
ambiguous instruction, a missing piece, or would just like to ask a question, we'll try our best to help out.

help@oomlout.com
\ (we like hearing about problems it helps us improve future versions) j

Thanks For Choosing .:oomlout:.
and SparkFun
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. INSTALLING THE IDE :. 02 INST

This is the program used to write code for the Arduino. It may installing
seem a little daunting at first but once you have it installed and ERREEe S REFERETE)
start playing around, its secrets will reveal themselves.

Step 1: Download the software

Go to

http://arduino.cc/en/Main/Software
download the software for your operating system

Windows XP Mac OSX

>

Step 2: Unzip the Software Step 2: Open The .dmg
Unzip Open (mount)
arduino-00 X X -Win.zip (x x- version #) arduino-00 X X -mac.dmg (x x- version #)

Recommended Path

c:\Program Files\

Step 3: Copy The Application
Step 3: Shortcut Icon . Goto
Open Arduing" (in the devices section of finder)
c:\program files\arduino-00X X\ (xx- version #) " o Mo‘_’e .
Right Click Arduino" Application to the
Arduino.exe (send to>Desktop (create shortcut)) "Applications" folder

Step 4: Install Drivers

Go to
"Arduino" device
Double Click & Install

FTDI Drivers for Intel Macs (X X X X).pkg
(FTDI Drivers for PPC Macs (X__ X X X).pkg
Restart

Using the included USB cable, plug your Arduino
board into a free USB port.

Wait for a box to pop up

)

Step 4: Plug In Your Arduino
Plug your Arduino in:

B )

Step 5: Add new Hardware

Skip searching the internet
(click the next box when prompted to do so)
Install from a specific location
(click “Install from a list or specific location (Advanced)")
Choose the Location
c:\program files\arduino-00 X X \drivers\FTDI USB Drivers\
Finished

Step 5: Plug In Your Arduino

Plug your Arduino in:
Using the included USB cable, plug your Arduino
board into a free USB port.

Finished

e )

4T

.. NOTE: :.
.: Encountering problems? :.
.: Would like more details? Using Linux? :.
.t http://ardx.org/LINU :.

-
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programming
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.:A Small Programming Primer:.\

[ARDUINO PROGRAMMING IN BRIEF
The Arduino is programmed in the C language. This is a quick little primer targeted at people
who have a little bit of programing experience and just need a briefing on the idiosyncracies of C
and the Arduino IDE. If you find the concepts a bit daunting, don't worry, you can start going
through the circuits and pick up most of it along the way. For a more in-depth intro, the
Qrduino.cc website is a great resource.

\

[STRUCTU RE

AN

Each Arduino program
(often called a sketch) has
two required functions
(also called routines).

void setup(QQ{ 1}
All the code between the two
curly brackets will be run once
when your Arduino program
first runs.

void loop(QQ{ 1}
This function is run after setup
has finished. After it has run
once it will be run again, and
again, until power is removed.

|

[SYNTAX

~ .

( \

One of the slightly
frustrating elements of C is
its formatting requirements
(this also makes it very
powerful). If you remember
the following you should be

\alright.

J/

\_

/| (single line comment)
It is often useful to write notes
to yourself as you go along
about what each line of code
does. To do this type two
forward slashes and everything
until the end of the line will be
\ignored by your program.

e ™
{ } (curly brackets)

Used to define when a block

of code starts and ends (used

in functions as well as loops).
| J

7’

|

[* *[(multiline comment)
If you have a lot to say you can
span several lines as a
comment. Everything between
these two symbols will be
ignored in your program.

7

|

7 (semicolon)
Each line of code must be
ended with a semicolon (a
missing semicolon is often
the reason for a program
refusing to compile).

KIARIABLES

A program is nothing more
than instructions to move
numbers around in an
intelligent way. Variables are
L used to do the moving.

7

int (integer)
The main workhorse, stores a
number in 2 bytes (16 bits).
Has no decimal places and will
store a value between -32,768
\_and 32,767.

7

\.

J
long (long) )
Used when an integer is not
large enough. Takes 4 bytes (32
bits) of RAM and has a range
between -2,147,483,648 and
2,147,483,647.

boolean (boolean)
A simple True or False
variable. Useful
because it only
uses one bit of
RAM.

float (float)

Used for floating point math
(decimals). Takes 4 bytes (32
bits) of RAM and has a range
between -3.4028235E+38
and 3.4028235E+38.

\. J

\.

char (character)
Stores one character using the
ASCII code (ie 'A' = 65). Uses
one byte (8 bits) of RAM. The
Arduino handles strings as an
array of char’s.

=~




( .:For a full programming reference visit:.
http://ardx.org/PROG
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(MATH OPERATORS

\

Operators used for
manipulating numbers.
(they work like simple
math).

-

= (assignment) makes something equal to something else (eg. x
=10 * 2 (x now equals 20))

% (modulo) gives the remainder when one number is divided by
another (ex. 12 % 10 (gives 2))

+ (addition)

- (subtraction)

*  (multiplication)

/  (division)

[COMPARISON OPERATORS

AN

Operators used for
logical comparison.

\_

(equal to) (eg. 12 == 10 is FALSE or 12 == 12 is TRUE)
(not equal to) (eg. 12 1= 10/is TRUE or 12 1= 12 is FALSE)
(less than) (eg. 12 < 10 is FALSE or 12 < 12 is FALSE or 12 < 14 is TRUE)

(greater than) (eg. 12 > 10is TRUE or 12 > 12 is FALSE or 12 > 14 is
FALSE)

V A

J

[CONTROL STRUCTURE

J

Programs are reliant on
controlling what runs

next, here are the basic
control elements (there
are many more online).

\_

if(condition){ }

else if( condition ){ }
else { }

This will execute the code between
the curly brackets if the condition
is true, and if not it will test the
else if condition if that is also
false the e1se code will execute.

for(int i = 0; i <
#repeats; i++){ 3
Used when you would like to
repeat a chunk of code a number
of times (can count up i++ or
down i-- or use any variable)

-

[DIGITAL

J

pinMode(pin, mode);

Used to set a pin's mode, pin
is the pin number you would
like to address 0-19 (analog 0-
5 are 14-19). The mode can
either be INPUT or OUTPUT.

int digitalRead(pin);

Once a pin is set as an INPUT
you can use this to return

digitalwrite(pin, value);

Once a pin is set as an OUTPUT,
it can be set either HIGH (pulled

to +5 volts) or LOW (pulled to
ground).

whether it is HIGH (pulled to
+5 volts) or LOW (pulled to

g

ground).

-

/ANALOG

~

The Arduino is a digital

to operate in the analog
realm (through tricks).
Here's how to deal with
things that aren't digital.

machine but it has the ability

int analogwrite(pin,

Some of the Arduino's pins support
pulse width modulation (3, 5, 6, 9, 10,
11). This turns the pin on and off very
quickly making it act like an analog
output. The value is any number
between 0 (0% duty cycle ~0v) and
255 (100% duty cycle ~5 volts).

int analogRead(pin);

value); ’ ’
When the analog input pins are set

to input you can read their voltage.
A value between 0 (for 0
volts) and 1024 (for
5 volts) will be
returned.

\S
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clectronics .:A Small Electronics Primer:. \

primer

[ELECTRONICS IN BRIEF \
No previous electronic experience is required to have fun with this kit. Here are a few details

about each component to make identifying, and perhaps understanding them, a bit easier. If
at any point you are worried about how a component is used or why it's not working the
Qternet offers a treasure trove of advice, or we can be contacted at help@oomlout.com

J
/ COMPONENT DETAILS N\

LED What it Does: No. of Leads:
(Light Emitting Diode)  Emits light when a small current is 2 (one longer, this one connects to positive)
passed through it. (only in one direction) Things to watch out for:
Identifying: - Will only work in one direction
Looks like a mini light bulb. - Requires a current limiting resistor
More Details:
http://ardx.org/LED
What it Does: No. of Leads:
The electronic equivalent of a one way 2
valve. Allowing current to flow in one Things to watch out for:
direction but not the other. - Will only work in one direction (current wil
Identifying: flow if end with the line is connected to ground)
Usually a cylinder with wires extending from More Details:
either end. (and an off center line indicating polarity) http://ardx.org/DIOD
Resistors What it Does: No. of Leads:
p Restricts the amount of current that can 2
( flow through a circuit. Things to watch out for:
Identifying: - Easy to grab the wrong value (double
Cylinder with wires extending from either check the colors before using)
end. The value is displayed using a color More Details:

coding system (for details see next page) http://ardx.org/RESI

Transistor What it Does: No. of Leads:
Uses a small current to switch or amplify a 3 (Base, Collector, Emitter)
’ much larger current. Things to watch out for:
. Identifying: - Plugging in the right way round (aiso a
Comes in many different packages but you current limiting resistor is often needed on the base pin)
can read the part number off the package. More Details:
(P2N2222AG in this kit and find a datasheet online) http://ardx.org/TRAN
Hobby Servo What it Does: No. of Leads:
Takes a timed pulse and converts it into 3
an angular position of the output shaft. Things to watch out for:
Identifying: - The plug is not polarized so make sure
A plastic box with 3 wires coming out one it is plugged in the right way.
side and a shaft with a plastic horn out More Details:
the top. http://ardx.org/SERV
DC Motor What it Does: No. of Leads:
Spins when a current is passed through it. 2
\\X Identifying: Things to watch out for:
This one is easy, it looks like a motor. - Using a transistor or relay that is rated
2 4 Usually a cylinder with a shaft coming out for the size of motor you're using.
of one end. More Details:

http://ardx.org/MOTO /J
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[COMPONENT DETAILS (CONT.) primer

Piezo Element
What it Does:
A pulse of current will cause it to click. A No. of Leads:

stream of pulses will cause it to emit a 2
tone. Things to watch out for:
Identifying: - Difficult to misuse.

In this kit it comes in a little black barrel, = More Details:
but sometimes they are just a gold disc. http://ardx.org/PIEZ

IC (Integrated Circuit)

What it Does: No. of Leads:
Packages any range of complicated 2 - 100s (in this kit there is one with 3 (TMP36) and
electronics inside an easy to use package. one with 16 (74HC595)
% Identifying: Things to watch out for:
[5f The part ID is written on the outside of the - Proper orientation. (look for marks showing pin 1)

package. (this sometimes requires a lot of More Details:
light or a magnifying glass to read). http://ardx.org/ICIC

Pushbutton What it Does: No. of Leads:
Completes a circuit when it is pressed. 4

Identifying: Things to watch out for:
A little square with leads out the bottom - these are almost square so can be
and a button on the top. inserted 90 degrees off angle.

More Details:
http://ardx.org/BUTT

Potentiometer
What it Does: No. of Leads:
Produces a variable resistance dependant 3
on the angular position of the shaft. Things to watch out for:
Identifying: - Accidentally buying logarithmic scale.
They can be packaged in many different ~ More Details:
form factors, look for a dial to identify. http://ardx.org/POTE
Photo Resistor
What it Does: No. of Leads:
Produces a variable resistance dependant 2
‘ on the amount of incident light. Things to watch out for:
Identifying: - Remember it needs to be in a voltage
@ Usually a little disk with a clear top and a divider before it provides a useful input.
curvy line underneath. More Details:

http://ardx.org/PHOT

-

AN

[RESISTOR CoLoR CoODE first digit ) ﬂEAD CLIPPING
Examples: —second digit Some components in this kit come with very long wire
grsenj’lued’brgvg (; 550 Oh?ik —# of zeros leads. To make them more compatible with a breadboard
red-reda-red - ohms (2. i
brown-black-orange - 10 0(00 ogms (10K tolerance iECgL;?Ie of changes are required.
{ IP Clip the leads so the long lead is ~10mm (3/8") long and
the short one is ~7mm (9/32").
— Resistors:
Bend the leads down so they are 90 degrees to the
MO - Black M5 - Green 20% - none cylinder. Then snip them so they are ~6mm
M1-Brown M6 -Blue 10% - silver (1/4") long.
M2 - Red M7 - Purple 5% - gold Other Components: o
3-Orange M8 - Grey Other components may need clipping.

t4 - Yellow ]9 - White j %your discretion when doing so. / ﬂ




.:Getting Started.:. \
.:(Blinking LED):.

CIRC-01

("WHAT WE'RE DOING:

LEDs (light emitting diodes) are used in all sorts of clever things
which is why we have included them in this kit. We will start off
with something very simple, turning one on and off, repeatedly,
producing a pleasant blinking effect. To get started, grab the parts
listed below, pin the layout sheet to your breadboard and then plug
everything in. Once the circuit is assembled you'll need to upload the program. To do this plug the
Arduino board into your USB port. Then select the proper port in Tools > Serial Port > (the
comm port of your Arduino). Next upload the program by going to File > Upload to I/0
Board (ctrl+U). Finally, bask in the glory and possibility that controlling lights offers.

If you are having trouble uploading, a full trouble shooting guide can be found here: http://ardx.org/TRBL

\§ J
ﬁ HE CIRCUIT: \

CIRC-01 . R
2 Pin Header 5mm Yellow LED

Breadboard Sheet J) Y x1 Wire

x1 x4 Ir /\

330 Ohm Resistor

Orange-Orange-Brown

x1

ﬂ’arts:
A

Schematlc

Arduino
pin 13

Ionger lead

LED
(light emitting diode)

resistor (3300hm)
(orange-orange-brown)

gnd
(ground) )

(  The Internet )

.:download:.
breadboard layout sheet
http://ardx.org/BBLS01S
view:.
assembly video
http://ardx.org/VIDEO1

3




@0DE (no need to type everything in just click)

File > Examples > Digital > Blink
(example from the great arduino.cc site, check it out for other ideas)

/* Blink

“ Turns on_an LED on for one second, then off for one second,
* repeatedly.

* Created 1 June 2005 By David Cuartielles
http://arduino.cc/en/Tutorial/Blink

based on an orginal by H. Barragan for the wiring i/o board

int ledpin = 13; // LED connected to digital pin 13

// The setup() method runs once, when the sketch starts
void setup() { // initialize the digital pin as an output:
pinMode(TedpPin, OUTPUT); }

// the Toop() method runs over and over again,
// as long as the Arduino has power

vo1d Toop QO
?1ta‘IWr‘1te(‘IedP1n, HIGH); // set the LED on
ay (1000) ; // wait for a second
d1g1ta'|wr1te('|edP1'n, Low) ; // set the LED off
deTay(1000); // wait for a second

\

[NOT WORKING? (3 things to try)

N\ a N\ {
LED Not Lighting Up? Program Not Uploading
LEDs will only work in one This happens sometimes, Still No Success?
direction. Try taking it out and the most likely cause is a A broken circuit is no fun, send
twisting it 180 degrees. . us an e-mail and we will get
) - nfi rial

(no need to worry, installing it confused seria pc_)rtf you back to you as soon as we can.
backwards does no permanent can change this in

harm). tools>serial port> help@oomlout.com

Q J \\ J \

2/

[MAKING IT BETTER

delay(time on); //(seconds * 1000)

digitalwrite(ledpin, Low); File > Examples > Analog > Fading

then out.

~

Changing the pin: Control the brightness:
The LED is connected to pin 13 but we can use any of Along with digital (on/off) control the Arduino can control
the Arduino’s pins. To change it take the wire plugged some pins in an analog (brightness) fashion. (more details on
into pin 13 and move it to a pin of your choice (from 0- this in later circuits). To play around with it.
13) (you can also use analog 0-5, analog 0 is 14...) Change the LED to p|n 9: (also change the W|re)
Then in the code change the line: ledPin = 13; -> int ledpin = 9;
int ledPin = 13; -> int TedPin = newpin; Replace the code inside the { }'s of Toop() with this:

Then upload the sketch: (ctrl-u) analogwrite(ledPin, new number);
Change the blink time: (new number) = any number between 0 and 255.
Unhappy with one second on one second off? 0 = off, 255 = on, in between = different brightness
In the code change the lines: Fading:

digitalwrite(ledPin, HIGH); We will use another included example program. To open go to

delay(time off); //(seconds * 1000) Then upload to your board and watch as the LED fades in and

J

mORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

\\ http://ardx.org/CIRCO1




.:8 LED Fun:.
.:Multiple LEDs:.

(WHAT WE'RE DOING:

We have caused one LED to blink, now it's time to up the
stakes. Lets connect eight. We'll also have an opportunity to
stretch the Arduino a bit by creating various lighting
sequences. This circuit is also a nice setup to experiment with
writing your own programs and getting a feel for how the Arduino works.

Along with controlling the LEDs we start looking into a few simple programming methods to
keep your programs small.

for() loops - used when you want to run a piece of code several times.
arrays[] - used to make managing variables easier (it's a group of variables).

J

ﬁl‘ HE CIRCUIT:

ﬁ’arts:
CIRC-02 2 Pin Header ﬂ 5mm Yellow LED

R Breadboard Sheet & & wi
d x1 x4 ]r x8 /—\ ire
330 Ohm Resistor
ﬂ Orange-Orange-Brown
K x8

/ Schematic \

pin 2 pin 3pin 4 pin 5

23 23 LED

resistor
3300hm
—=—gnd

pin 6 pin 7 pin 8 pin 9

3 3 LED

resistor
3300hm

\ —gnd /
( The Internet \

.:download:.
breadboard layout sheet
http://ardx.org/BBLS02S
sview:.
assembly video

http://ardx.org/VIDEO2

.




@0DE (no need to type everything in just click)

//LED Pin variables

int ledpins(] = {2,3,4,5,6,7,8,9};
//An array to hold the
//pin each LED is connected to
//i.e. LED #0 is connected to pin 2

void setupQ

for(int i = 0; i < 8; i++){
//this is a Toop and will repeat eight times
pinMode(TedPins[i],0UTPUT);
' //we use this to set LED pins to output
}
void Toop() // run over and over again
oneAfterAnotherNoLoop(Q);
//this will turn on each LED one by
//one then turn each oneoff
//oneAfterAnotherLoop();
//this does the same as onAfterAnotherNoLoop
//but with much Tless typing
//oneonAtATime();
//inAndout();

oneAfterAnotherNoLoop() - will Tight one then
\\~>de1ay for delayTime then Tlight the next LED it

Download the Code from ( http://ardx.org/CODEO02 )
(and then copy the text and paste it into an empty Arduino Sketch)

* will then turn them off

void oneAfterAnotherNoLoop(){
int delayTime = 100;
//the time (in m1111seconds) to pause
//between LEDs
digitalwrite(ledPins[0], HIGH); //Turns on LED #0
//(connected to pin 2)

delay(delayTime); //waits delayTime milliseconds

digitalwrite(ledPins[7], HIGH);
//(connected to pin 9)
//waits delayTime milliseconds

//Turns on LED #7

de1ay(de1ayT1me),
//Turns Each

d1g1ta1wr1te(1edP1ns[7], Low); //Turns off LED #7

deTay(delayTime); //waits delayTime milliseconds

[NOT WORKING? (3 things to try)

7

N\ ( N

Starting Afresh

Some LEDs Fail to Light
It is easy to insert an LED
backwards. Check the LEDs

that aren't working and ensure
they the right way around.

Operating out of sequence
With eight wires it's easy to cross
a couple. Double check that the
first LED is plugged into pin 2 and
each pin there after.

Its easy to accidentally
misplace a wire without
noticing. Pulling everything out
and starting with a fresh slate
is often easier than trying to
track down the problem.

N\

2/

~

[MAKING IT BETTER

Switching to loops:

In the loop() function there are 4 lines. The last
three all start with a '//'. This means the line is
treated as a comment (not run). To switch the
program to use loops change the void Toop()

code to:
//oneAfterAnotherNoLoop();
oneAfterAnotherLoop();
//oneonAtATime();
//inAndout();
Upload the program, and notice that nothing has
changed. You can take a look at the two
functions, each does the same thing, but use

different approaches (hint: the second one uses

\a for loop).

Extra animations:

Tired of this animation? Then try the other two
sample animations. Uncomment their lines and upload
the program to your board and enjoy the new light
animations. (delete the slashes in front of row 3 and then 4)

Testing out your own animations:
Jump into the included code and start changing

things. The main point is to turn an LED on use

digitalwrite(pinNumber, HIGH); then to turn
it off use digitalwrite(pinNumber, LOW); .

Type away, regardless of what you change you won't
break anything.

J

mORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC02

\




.:Spin Motor Spin:.
.:Transistor & Motor:.

) N
(WHAT WE'RE DOING: \ 2
The Arduino's pins are great for directly controlling small electric Ao~

items like LEDs. However, when dealing with larger items (like a

toy motor or washing machine), an external transistor is required. A
transistor is incredibly useful. It switches a lot of current using a

much smaller current. A transistor has 3 pins. For a negative type (NPN)
transistor, you connect your load to collector and the emitter to ground. Then when a small current
flows from base to the emitter, a current will flow through the transistor and your motor will spin
(this happens when we set our Arduino pin HIGH). There are literally thousands of different types of
transistors, allowing every situation to be perfectly matched. We have chosen a P2N2222AG a rather
common general purpose transistor. The important factors in our case are that its maximum voltage
(40v) and its maximum current (200 milliamp) are both high enough for our toy motor (full details
can be found on its datasheet http://ardx.org/2222).

k (The 1N4001 diode is acting as a flyback diode for details on why its there visit: http://ardx.org/4001)

ﬂl‘ HE CIRCUIT: \
f Parts:

CIRC-03 ) Transistor .
<> Breadboard Sheet $  27inHeader m P2N22224G (T052) N Wire
X
Diode 10k Ohm Resistor
W, Tov Motor ® (1ns001) | Brown-Black-Orange
\ x x1 -

/ Schematic \

Arduino
pin9

The transistor will have
P2N2222AG printed on it
(some variations will have
different pin assignments!)

gnd
(ground) (-)

+5 volts

( The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS03S
view:.
assembly video

http://ardx.org/VIDEO3

.:NOTE: if your arduino is resetting you need to install the optional capacitor:. /j




[CODE (no need to type everything in just click)

int motorPin =
void setup() //runs once

}p‘i nMode (motorPin, OUTPUT);

\{/o'id Toop(Q) // run over and over again
motoronThenoff();
//motoronThenoffwithspeed();
//motorAcceleration();

Download the Code from ( http://ardx.org/CODEO3 )
(then simply copy the text and paste it into an empty Arduino Sketch)

9; //pin the motor is connected to

void motoronThenoffwithspeed(){
int onSpeed = 200;// a number between
0 (stopped) and 255 (full speed)
int onTime = 2500;
int offspeed = 50;// a number between
//0 (stopped) and 255
int offTime = 1000;
analogwrite(motorPin, onSpeed);
// turns the motor On
delay(onTime); // waits for onTime milliseconds
analogwrite(motorpin, offSpeed);

(full speed)

/1\'

* motoronThenoff() - turns motor on then off

* (notice this code is identical to the code we
used for

* the b11nk1ng LED)

vmd motoronThenoff(){
int onTime = 2500; //on time

int offTime = 1000 //off time

d1g1ta'|wr1te(motorP1n, HIGH) ;

/ turns the motor On
delay(onTime); // waits for onTime milliseconds
digitalwrite(motorpPin, LOW);

/ turns the motor off
delay(offTime);// waits for offTime milliseconds

\.

delay(offTime);

void motorAcceleration(){
int delayTime =
for(int i =

for(int i

// turns the motor Off
// waits for offTime milliseconds

50; //time between each speed step
0; i < 256; i++){

//goes through each speed from 0 to 255
analogwrite(motorpin, 1i); //sets the new speed
delay(delayTime);// waits for delayTime milliseconds

255; 1 >= 0; -)9{

//goes through each speed from 255 to 0
analogwrite(motorpPin, i); //sets the new speed
delay(delayTime);//waits for delayTime milliseconds

J

\

[NOT WORKING? (3 things to try)
{ 3 {
Motor Not Spinning?
If you sourced your own
transistor, double check with
the data sheet that the pinout
is compatible with a
P2N2222AG
(many are reversed).

Still No Luck?

If you sourced your own
motor, double check that it will
work with 5 volts and that it
does not draw too much
power.

N\ ( N

Still Not Working?
Sometimes the Arduino board
will disconnect from the
computer. Try un-plugging and
then re-plugging it into your
USB port.

2/

[MAKING IT BETTER

Controlling speed:

We played with the Arduino's ability to control the
brightness of an LED earlier now we will use the same
feature to control the speed of our motor. The Arduino
does this using something called Pulse Width
Modulation (PWM). This relies on the Arduino's ability to
operate really, really fast. Rather than directly
controlling the voltage coming from the pin the Arduino
will switch the pin on and off very quickly. In the
computer world this is going from 0 to 5 volts many
times a second, but in the human world we see it as a
voltage. For example if the Arduino is PWM'ing at 50%
we see the light dimmed 50% because our eyes are not
quick enough to see it flashing on and off. The same
feature works with transistors. Don't believe me? Try it

\out.

~

In the Toop () section change it to this

// motoronThenoff();
motoronThenoffwithspeed();

// motorAcceleration();

Then upload the program. You can change the speeds by

changing the variables onSpeed and offSpeed.

Accelerating and decelerating:

Why stop at two speeds, why not accelerate and decelerate

the motor. To do this simply change the loop() code to read

// motoronThenoff();

// motoronThenoffwithspeed();
motorAcceleration();

Then upload the program and watch as your motor slowly
accelerates up to full speed then slows down again. If you
would like to change the speed of acceleration change the
variable delayTime (larger means a longer acceleration time).

mORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRCO3

-




.:A Single Servo:.
.:Servos:.

(" WHAT WE'RE DOING:

Spinning a motor is good fun but when it comes to projects
where motion control is required they tend to leave us
wanting more. The answer? Hobby servos. They are mass
produced, widely available and cost anything from a couple of
dollars to hundreds. Inside is a small gearbox (to make the movement more powerful) and
some electronics (to make it easier to control). A standard servo is positionable from 0 to
180 degrees. Positioning is controlled through a timed pulse, between 1.25 milliseconds (0
degrees) and 1.75 milliseconds (180 degrees) (1.5 milliseconds for 90 degrees). Timing
varies between manufacturer. If the pulse is sent every 25-50 milliseconds the servo will run
smoothly. One of the great features of the Arduino is it has a software library that allows
Qou to control two servos (connected to pin 9 or 10) using a single line of code. j

/ THE CIRCUIT: \
f Parts:

P CIRC-04 2 Pin Header p 3 PinHeader

Q/ :;eadboard Sheet $ a ¥ /—\ Wire

’}{ Mini Servo
K ‘ x1

( Schematic \

Arduino_____
pin 9

Mini Servo
signal
(white)

+5v
gnd (red)

(black)

gnd—=
(ground) (1) —

+5 volts
\ V) /
(  The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS04S
view:.
assembly video
http://ardx.org/VIDEO04

—

.




[CODE (no need to type everything in just click)

File > Examples > Library-Servo > Sweep
(example from the great arduino.cc site, check it out for other great ideas)

// Sweep
// by BARRAGAN <http://barraganstudio.com>

#include <Servo.h>
Servo myservo; // create_servo object to control a servo
int pos = 0; // variable to store the servo position

void setup() {
myservo.attach(9); // attaches the servo on pin 9 to the servo object

void Toop() {
for(pos = 0; pos < 180; pos += 1) // goes from 0 degrees to 180 degrees
{ // in steps of 1 degree

myservo.write(pos); // tell servo to go to position in variable 'pos'
delay(15); // waits 15ms for the servo to reach the position
for(pos = 180; pos>=1; pos-=1) // goes from 180 degrees to 0 degrees
myservo.write(pos); // tell servo to go to position in variable 'pos'
delay(15); // waits 15ms for the servo to reach the position
\J_ J
[NOT WORKING? (3 things to try) )
a N\ a N\ { N
Fits and Starts
Servo Not Twisting? Stlll Not Worklpg Itf t:ehservo I;etgr:ns Enowfr;g t'if.men
Even with colored wires it is A mistake .we made a t|.me or Iiwr:tcO:s,oaur: Ar diriij ta>oaarz| Itnhge
still shockingly easy to plug a two was simply forgetting to gower Zu I vou are usin’ i
servo in backwards. This might connect the power (red and POWer Supply v 9
be the case. brown wires) to +5 volts and not quite up to the challenge.

Using a fresh battery instead of
USB should solve this problem.

Q J \ J \ Jj
\

ground.

[MAKING IT BETTER

Potentiometer control:

N L . " void Too
We have yet to experiment with inputs but if you would like int pull’seﬁme = 2100; //(the numb]ecr of mw‘crgsegonds
B . s to pause for (1500 90 degrees
to read ahead, there is an example program File > Library- % 908 3 degreeg 2100 180 3egrees)
Servo > Knob. This uses a potentiometer (CIRC08) to g‘91ta1"“”te(5er"°"1"' HIGH) ;
eTayMicroseconds(pulseTime);
control the servo. You can find instructions online here: g;%;t?;ggne(servown, Low) ;
http://ardx.org/KNOB Y !
Self timing: Great ideas:

While it is easy to control a servo using the Arduino's included ~ Servos can be used to do all sorts of great things, here are a few of
library sometimes it is fun to figure out how to program our favorites.
something yourself. Try it. We're controlling the pulse directl
9V . v 9 P v Xmas Hit Counter
so you could use this method to control servos on any of the http://ardx.org/XMAS
Arduino's 20 available pins (you need to highly optimize this

code before doing that). Open Source Robotic Arm (uses a servo controller as well as the Arduino)
. . http://ardx.org/RARM
int servoPin = 9;

void setupO{ . Servo Walker
\} pinMode(servopPin,OUTPUT) ; http://ardx.org/SEWA j

mORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

\ http://ardx.org/CIRC04




CIRC-05 .:8 More LEDs:.
.:74HC595 Shift Register:.

'\ WHAT WE'RE DOING:

Time to start playing with chips, or integrated circuits (ICs) as they like to
be called. The external packaging of a chip can be very deceptive. For
example, the chip on the Arduino board (a microcontroller) and the one we
will use in this circuit (a shift register) look very similar but are in fact rather

different. The price of the ATMega chip on the Arduino board is a few dollars
while the 74HC595 is a couple dozen cents. It's a good introductory chip, and once you're comfortable playing
around with it and its datasheet (available online http://ardx.org/74HC595 ) the world of chips will be your oyster.
The shift register (also called a serial to parallel converter), will give you an additional 8 outputs (to control LEDs
and the like) using only three Arduino pins. They can also be linked together to give you a nearly unlimited
number of outputs using the same four pins. To use it you “clock in” the data and then lock it in (latch it). To do
this you set the data pin to either HIGH or LOW, pulse the clock, then set the data pin again and pulse the clock
repeating until you have shifted out 8 bits of data. Then you pulse the latch and the 8 bits are transferred to the
shift registers pins. It sounds complicated but is really simple once you get the hang of it.

(for a more in depth look at how a shift register works visit: http://ardx.org/SHIF)

J
ﬁ HE CIRCUIT: \
f Parts:

CIRC-05

" Shift Register
1 2 Pin Header
> Breadboard Sheet w 74HC595 Wire
x1 x4 x1 /\
330 Ohm Resistor
* Red LED fc H Orange-Orange-Brown

x8 x8

Schematic \

+5 volts

N\(

pin pin pin
4 3 2
74H|C595

resistor
(3300hm)

LED

+5V

(ground) (-)

data
clock
latch

_|_ gnd

There is a half moon
cutout, this goes at the top

NOUDAWN = O

[..

gnd

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS05S
view:.
assembly video
http://ardx.org/VIDEO5




(CODE (no need to type everything in just click)

//Pin Definitions

//The 74HC595 uses a protocol called SPI
//which has three pins

int data = 2;

int clock = 3;

int latch = 4;

void setup() //runs once

pinMode(data, OUTPUT);
pinMode(clock, OUTPUT);
pinMode(latch, ouTPUT); }
void Toop(Q) // run over and over again
int delayTime = 100;
//delay between LED updates
for(int i = 0; 1 < 256; i++){
updateLEDs(i);
delay(delayTime); }

* updateLEDs() - sends the LED states set
* in value to the 74HC595 sequence

/
Qﬂ' d updateLEDs(int value){

Download the Code from ( http://ardx.org/CODEOS )
(copy the text and paste it into an empty Arduino Sketch)

digitalwrite(latch, Low);

//Pulls the chips latch Tlow
shiftout(data, clock, MSBFIRST, value);

//shifts out 8 bits to the shift register

digitalwrite(latch, HIGH);

//Pulls the latch high displaying the data

\

[NOT WORKING? (3 things to try)

{ 3
The Arduino’s power
LED goes out
This happened to us a couple
of times, it happens when the
chip is inserted backwards. If
you fix it quickly nothing will
break.

Not Quite Working
Sorry to sound like a broken
record but it is probably
something as simple as a
crossed wire.

N\ ( D
Frustration?

Shoot us an e-mail, this circuit
is both simple and complex at
the same time. We want to
hear about problems you have
so we can address them in
future editions.
help@oomlout.com

N\ A

2/

Doing it the hard way:
An Arduino makes rather complex actions very easy, shifting out data is
one of these cases. However one of the nice features of an Arduino is
you can make things as easy or difficult as you like. Let's try an
example of this. In your loop switch the line:

updateLEDs(i) -> updateLEDsLong(i);
Upload the program and notice nothing has changed. If you look at the

code you can see how we are communicating with the chip one bit at a
time. (for more details http://ardx.org/SPI ).

Controlling individual LEDs:

Time to start controlling the LEDs in a similar method as we did in
CIRCO2. As the eight LED states are stored in one byte (an 8 bit value)
for details on how this works try http://ardx.org/BINA. An Arduino is
very good at manipulating bits and there are an entire set of operators
that help us out. Details on bitwise maths ( http://ardx.org/BITW ).

Our implementation.
Replace the Toop () code with
int delayTime = 100; //the number of milliseconds
//to delay

~

//between LED updates
forCint i = 0; 1 < 8; i++){
changeLED(i,0N);
delay(delayTime);

forGint i = 0; 1 < 8; i+8{
changeLED(i,0FF);
delay(delayTime);
Uploading this will cause the lights to light up one after another and then off
in a similar manner. Check the code and wikipedia to see how it works, or
shoot us an e-mail if you have questions.

More animations:

Now things get more interesting. If you look back to the code from CIRC02 (8
LED Fun) you see we change the LEDs using digitalWrite(led, state), this is
the same format as the routine we wrote changeLED(led, state). You can use
the animations you wrote for CIRC02 by copying the code into this sketch and
changing all the digitalWrite()'s to changeLED()'s. Powerful? Very. (you'll also
need to change a few other things but follow the compile errors and it works
itself out).

J

mORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRCO5

-




.:Music:.
.:Piezo Elements:.

("WHAT WE'RE DOING:

To this point we have controlled light, motion, and
electrons. Let's tackle sound next. But sound is an
analog phenomena, how will our digital Arduino cope?
We will once again rely on its incredible speed which will let it

mimic analog behavior. To do this, we will attach a piezo element to one of the
Arduino's digital pins. A piezo element makes a clicking sound each time it is pulsed
with current. If we pulse it at the right frequency (for example 440 times a second to
make the note middle A) these clicks will run together to produce notes. Let's get to
experimenting with it and get your Arduino playing "Twinkle Twinkle Little Star".

ﬁ' HE CIRCUIT: \
/ Parts:

CIRC-06 2 Pin Header . Piezo Element

> Breadboard Sheet @ x4 X1 /\ Wire

x1

Schematic

Arduino
pin 9

— Piezo
—— Element

—L gnd
(ground) (-)

(  The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS06S
Jaview:.
assembly video
http://ardx.org/VIDE06

-/

.

\




[[CODE (no need to type everything in just click)

Download the Code from ( http://ardx.org/CODEO6 )
(copy the text and paste it into an empty Arduino Sketch)

/* Melody
* (cleft) 2005 D. cuartielles for K3

digitalwrite(speakerprin,

This example uses a piezo speaker to play melodies. It sends W) ;
a square wave of the appropriate frequency to the piezo, delayMicroseconds (tone) ;

-
o

* generating the corresponding tone. }

* The calculation of the tones is made following the ¥

* mathematical operation: void playNote(char note Jint duratwr\) {

M . char names[] = 9", 'b', '}
timeHigh = period / 2 = 1/ (2 * toneFrequency) int tones[] = { 1915 1700 Isio, 1432, 1275 '1136, 1014, 956

* where the different tones are described as in the table: // play the tone correspgm{nng to the note name

for (int i =0; i < 8; i++

rgote frequencgmpeHmod t1meH1gh3830 1015 Tf (names[i] == note) { '
*d 294 Hz 3400 1700 playTone(tones[i], duration);
*e 329 Hz 3038 1519 .
* f 349 Hz 2864 1432 }
*g 395 Hz 5352 12;;
*a 440 Hz 7 11
*b 493 Hz 2028 1014 void ;egup() {k T

c 523 Hz 1912 356 R pinMode(speakerpin, OUTPUT);

f~/http://www.arduino.cc/en/TutoriaVMechy vmd 100p0) {

for (int i = 0; i f]en th; i++) {

int speakerPin = if (notes[1] ==

1Rt Tength = 15; // theﬁrgumber m‘ notes } ge'lszygbeatsh] * tempo); // rest
Sharjnotes(] - 'ccogaagrieeddc 1; /'8 space reprasents z pest |} G aretnoresti, beats(il * tempo);
int tempo = 300; // pause between notes
void playTone(int tone, int duration) { 3 delay(tempo / 2 ¥
for (1on? i =0; i < duration * 1000L; i += tone * 2) {
digitalwrite(speakerpin, HIGH);
\ delaymicroseconds (tone); j

[NOT WORKING? (3 things to try) )

a 3 4 3 ( N
No Sound Can't Think While the Tired of Twinkle Twinkle
Given the size and shape of P >
. P Little Star?
the piezo element it is easy to Melody is Playing? The code is written so you can

Just pull up the piezo element
miss the right holes on the ! ) pullup A piez
whilst you think, upload your

breadboard. Try double program then plug it back in
checking its placement. ' get started.

N\ ) a 7

easily add your own songs,
check out the code below to

MAKING IT BETTER

Playing with the speed: char}names[] ={'c, 'd', 'e', 'f', 'g', 'a', 'b',
. =2 " Ty

The timing for each note is calculated based on int tones[] = { 1915, 1700, 1519, 1432, 1275, 1136,

variables, as such we can tweak the sound of each note 1014, 956 };

or the timing. To change the speed of the melody you Composing your own melodies:
need to change only one line. The program is pre-set to play "Twinkle Twinkle Little Star'
int tempo = 300; ---> int tempo = (new #)

however the way it is programmed makes changing the song
R easy. Each song is defined in one int and two arrays, the int

or a smaller number to speed it up. 1 h defines th ber of notes, the first

Tuning the notes: ength defines the number of notes, the first array

If you are worried about the notes being a little out of notes[] defines each note, and the second beats[]

tune this can be fixed as well. The notes have been defines how long each note is played. Some Examples:
Twinkle Twinkle Little Star

Change it to a larger number to slow the melody down,

calculated based on a formula in the comment block at int length = 15;
the top of the program. But to tune individual notes just char notes[] = "ccggaagffeeddc ";
. : . int beats[]' = {1, 1,1, 1, 1,1, 2,1,1, 1,1,
adjust their values in the tones[] array up or down 1,1, 2, 4'};
until they sound right. (each note is matched by its Ha 1Birthﬂa first line
. . int length =
name in the names[] (array ie. c = 1915) char nmg:es[] "ccdcfeccdegf "
\ int beats[] = {1111121111124}, j

mloms, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

\ http://ardx.org/CIRC06




.:Button Pressing:.
.:Pushbuttons:.

CIRC-07

((WHAT WE'RE DOING:

Up to this point we have focused entirely on outputs, time to
get our Arduino to listen, watch and feel. We'll start with a \
simple pushbutton. Wiring up the pushbutton is simple. There is

one component, the pull up resistor, that might seem out of place.
This is included because an Arduino doesn't sense the same way we do (ie button pressed,
button unpressed). Instead it looks at the voltage on the pin and decides whether it is HIGH
or LOW. The button is set up to pull the Arduino's pin LOW when it is pressed, however, when
the button is unpressed the voltage of the pin will float (causing occasional errors). To get the
Arduino to reliably read the pin as HIGH when the button is unpressed, we add the pull up
resistor.

\ (note: the first example program uses only one of the two buttons)

J

/ THE CIRCUIT: \
fParts:
S

CIRC-07 i Pushbutton
Breadboard Sheet § )2(4P|n Header @ x2 /\ Wire

e |
10k Ohm Resistor 330 Ohm Resistor
e Brown-Black-Orange m Orange-Orange-Brow! * Red LED
k | x2 x1 x1

/ Schematic \

Arduino
pin 2 pin 3
Arduino T+5volts [
pin 13
" resistor
LED (pull-up)
:‘; ::(jok ohm) ::]
resistor pushbutton
(330 ohm)
=

\T ?gTodund) ) /

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS07S
iview:.
assembly video
http://ardx.org/VIDEQO7




[CODE (no need to type everything in just click)

File > Examples > Digital > Button
(example from the great arduino.cc site, check it out for other great ideas)

CIRC-07

* Button

* by DojoDave <http://www.0j0.org>

* Turns on and off a Tight emitting diode(LED) connected to digital
* pin 13, when pressing a pushbutton attached to pin 7

* http: //www arduino.cc/en/Tutorial/Button

int ledPin = 13;
int inputPin = 2;
int val = 0;

void setup() {

pinMode(TedPin, OUTPUT);
pinMode(inputPin, INPUT);

// choose the pin for the LED
// choose the input pin (for a pushbutton)
// variable for reading the pin status

// declare LED as output
// declare pushbutton as input

void Toop(){
val = digitalRead(inputPin);

// read input value
if (val == HIGH) {

// check if the input is HIGH

) d]igitf;{t]WriteOedP'in, Low); // turn LED OFF
else
digitalwrite(ledPin, HIGH); // turn LED ON

\_

[NOT WORKING? (3 things to try)

{ 3 { 3 ( N

Light Not Turning On Light Not Fading

Underwhelmed?

The pushbutton is square
and because of this it is easy
to put it in the wrong way.
Give it a 90 degree twist and
see if it starts working.

A bit of a silly mistake we
constantly made, when you
switch from simple on off to

fading remember to move the
LED wire from pin 13 to pin 9.

No worries these circuits are all
super stripped down to make
playing with the components

easy, but once you throw them
together the sky is the limit.

N\ A

2/

MAKING IT BETTER
On button off button:
The initial example may be a little underwhelming (ie. I

don't really need an Arduino to do this), let's make it a
little more complicated. One button will turn the LED on

the other will turn the LED off. Change the code to:

int ledpPin = 13; // choose the pin for the LED
int inputPinl = 3; // button 1

int inputPin2 = 2; // button 2

void setup() {
pinMode(TedPin, OUTPUT); // declare LED as output
pinMode(inputPinl, INPUT); // make button 1 an input
pinMode(inputPin2, INPUT); // make button 2 an input

void Toop(){
if (digitalRead(inputPinl) == LOW) {
digitalwrite(ledpin, LOW); // turn LED OFF
} else if (d1g1ta'IRead(1nputP1n2) == Low) {
digitalwrite(ledPin, HIGH); // turn LED ON

Upload the program to your board, and start toggling the

\LED on and off.

~

Fading up and down:
Lets use the buttons to control an analog signal. To do this
you will need to change the wire connecting the LED from pin
13 to pin 9, also change this in code.

int ledpin = 13; ----> int ledpPin = 9;
Next change the loop() code to read.

int value = 0

vmd Toop ()

(d1%1ta'|Read(1nputP1 nl) == Low) { value--; }
(d1g1ta1kead(1nputP1n2) == Low) { va]ue++ }

e1se i
value = constrain(value, 0, 255);
analogwrite(ledPin, value);

N delay(10);

Changing fade speed:
If you would like the LED to fade faster or slower, there is only

one line of code that needs changlnq
delay(10); ----> delay(new #);

To fade faster make the number smaller, slower requires a
larger number.

J

mORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

-

http://ardx.org/CIRC07




.+ Twisting:.
..Potentiometers:.

CIRC-08

"WHAT WE'RE DOING:

Along with the digital pins, the Arduino also has 6
pins which can be used for analog input. These
inputs take a voltage (from 0 to 5 volts) and convert
it to a digital number between 0 (0 volts) and 1024 (5 volts) (10 bits of
resolution). A very useful device that exploits these inputs is a potentiometer
(also called a variable resistor). When it is connected with 5 volts across its
outer pins the middle pin will read some value between 0 and 5 volts
dependent on the angle to which it is turned (ie. 2.5 volts in the middle). We
\ .can then use the returned values as a variable in our program.

J
ﬁ HE CIRCUIT: \

ﬂ’arts:
CIRC-08

P " Potentiometer Wire
< Breadboard sheet ¢ 27" Header 10k ohm ™\
¥ ox X x1

330 Ohm Resistor

k ? Yellow LED m Orange-Orange-Brown
r x1 x1
7~ Schematic O\

+5 volts

Arduino
pin 13

Arduino

. analo
Potentiometer pin Dg

3 (light
emitting| ]
diode)

resistor (3300hm)
(orange-orange-brown)

\T (ggTochlnd) ) /

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS08S
aview:.
assembly video
http://ardx.org/VIDEOS8

\




CIRC-08

[CODE (no need to type everything in just click)
File > Examples > Analog > AnalogInput
(example from the great arduino.cc site, check it out for other great ideas)

/* Analog Input
* Demonstrates analog input by reading an analog sensor on analog
* pin 0 and turning on and off a Tight emitting diode(LED) connected to
digital pin 13.
* The amount of time the LED will be on and off depends on the value obtained by
* analogrRead() .
* Created by David Cuartielles
* Modified 16 Jun 2009
* By Tom Igoe
f/http://arduino.cc/en/Tutoria]/Ana]ogInput

int sensorPin = 0;
int ledPin = 13;
int sensorvalue = 0;

// select the input pin for the potentiometer
// select_the pin for the LED .
// variable to store the value coming from the sensor

void setup( {

pinMode(ledPin, OUTPUT); //declare the TedPin as an OUTPUT:

void Toop() {

sensorvalue = analogRead(sensorpin);// read the value from the sensor:

d'i?ita'lwrite('ledP'in, HIGH); // turn the ledPin on

delay(sensorvalue); // stop the program for <sensorvalue> milliseconds:
digitalwrite(ledPin, LOW); // turn the ledPin off:

delay(sensorvalue); // stop the program for for <sensorvalue> milliseconds:

AN

[NOT WORKING? (3 things to try)
{ 3 {
Not Working
Make sure you haven't

accidentally connected the
potentiometer's wiper to digital
pin 2 rather than analog pin 2.

(the row of pins beneath the

power pins)

\\: J \\ J \

Sporadically Working
This is most likely due to a
slightly dodgy connection with
the potentiometer's pins. This
can usually be conquered by
taping the potentiometer down.

Still Backward
You can try operating the
circuit upside down.
Sometimes this helps.

[MAKING IT BETTER

Threshold switching:

Sometimes you will want to switch an output when a value
exceeds a certain threshold. To do this with a
potentiometer change the Toop () code to.

void Toop() {

Then change the loop code to.
void Toop(Q)
int value = analogRead(potPin) / 4;
analogwrite(ledPin, value);

Upload the code and watch as your LED fades in relation to

int threshold = 512;

if(analogRead(sensorPin) > threshold){
digitalwrite(ledPin, HIGH);}

else{ digitalwrite(ledrin, LOW);}
This will cause the LED to turn on when the value is above
512 (about halfway), you can adjust the sensitivity by
changing the threshold value.
Fading:
Let’s control the brightness of an LED directly from the
potentiometer. To do this we need to first change the pin
the LED is connected to. Move the wire from pin 13 to pin

9 and change one line in the code.
\ int ledPin = 13; ----> int ledPin = 9;

your potentiometer spinning. (Note: the reason we divide the
value by 4 is the analogRead() function returns a value from 0
to 1024 (10 bits), and analogWrite() takes a value from 0 to
255 (8 bits) )

Controlling a servo:

This is a really neat example and brings a couple of circuits

together. Wire up the servo like you did in CIRC-04, then open
the example program Knob (File > Examples > Library-

Servo > Knob ), then change one line of code.
int potpin = 0; ----> int potpin = 2;
Upload to your Arduino and then watch as the servo shaft turns

as you turn the potentiometer.

J

mORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRCO08

-




.:Light:. \

..Photo Resistors:.

N\ WHAT WE'RE DOING:

Whilst getting input from a potentiometer can be useful
for human controlled experiments, what do we use

when we want an environmentally controlled

experiment? We use exactly the same principles but instead
of a potentiometer (twist based resistance) we use a photo resistor (light based
resistance). The Arduino cannot directly sense resistance (it senses voltage) so we
set up a voltage divider (http://ardx.org/VODI). The exact voltage at the sensing
pin is calculable, but for our purposes (just sensing relative light) we can
experiment with the values and see what works for us. A low value will occur when
kthe sensor is well lit while a high value will occur when it is in darkness.

J
ﬂl‘ HE CIRCUIT: \
( Parts:

p CIRC-09 . -
Y 2 Pin Header @  Photo-Resistor
<& . Breadboard Sheet § Wire
> B ¢ 4 ox1 /\
10k Ohm Resistor 330 Ohm Resistor
| Brown-Black-Orange Orange-Orange-Brov  ( Yellow LED
K | x1 | x1 ﬁ x1

( Schematic \

Arduino

+5 volts

< photo
< resistor

resistor
(3300hm)

—gnd

\~ (ground) (-) Y,

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS09S
view:.
assembly video
http://ardx.org/VIDE09




(c

ODE (no need to type everything in just click)

(copy the text and paste it into an empty Arduino Sketch)

A simple programme that will change the
* intensity of an LED based on the amount of
* Tight incident on the photo resistor.

*

*/

//PhotoResistor Pin
int 1lightPin = 0; //the analog pin the
//photoresistor 1is
//connected to
//the photoresistor is not
//calibrated to any units so
//this 1is simply a raw sensor
//value (relative Tight)
//LED Pin
int ledPin = 9;//the pin the LED is connected to
//we are controlling brightness so
//we use one of the pwMm (pulse
//width modulation pins)

void setup()
{

pinMode(ledPin, OUTPUT); //sets the led pin to

Download the Code from ( http://ardx.org/CODEQ9 )

//output
}

/\':
Toop() - this function will start after setup
finishes and then repeat

void Toop(Q)
{

analogrRead(1ightPin); //Read the
// Tightlevel
TightLevel = map(1ightLevel, 0, 900, 0, 255);
//adjust the value 0 to 900 to 0 to 255
TightLevel = constrain(lightLevel, 0, 255);
//make sure the value is betwween 0 and 255
analogwrite(ledpPin, TightLevel); //write the value
}

int lightLevel =

J

[NOT WORKING? (3 thmgs to try)

\

-
LED Remains Dark
This is a mistake we continue
to make time and time again,
if only they could make an LED
that worked both ways. Pull it
up and give it a twist.

It Isn't Responding to
Changes in Light.

Given that the spacing of the
wires on the photo-resistor is
not standard, it is easy to
misplace it. Double check its in
the right place.

N ( D

Still not quite working?

You may be in a room which is
either too bright or dark. Try
turning the lights on or off to

see if this helps. Or if you have

a flashlight near by give that a

try.

N\ A

2/

[MAKING IT BETTER

Reverse the response:
Perhaps you would like the opposite response. Don't

worry we can easily reverse this response just change:

analogwrite(ledPin, TightLevel); ---->
analogwrite(ledpPin, 255 - TightLevel);

Upload and watch the response change:

Night light:
Rather than controlling the brightness of the LED in

response to light, let's instead turn it on or off based on

a threshold value. Change the loop() code with.
void Toop(Q)
int threshold = 300;
if(anal o?Read (TightPin) > threshold){
digitalwrite(ledPin, HIGH);
Yelse{
digitalwrite(ledPin, LOW);

}

-

~

Light controlled servo:
Let's use our newly found light sensing skills to control a

servo (and at the same time engage in a little bit of Arduino
code hacking). Wire up a servo connected to pin 9 (like in
CIRC-04). Then open the Knob example program (the same
one we used in CIRC-08) File > Examples > Library-
Servo > Knob. Upload the code to your board and watch as

it works unmodified.
Using the full range of your servo:
You'll notice that the servo will only operate over a limited

portion of its range. This is because with the voltage dividing
circuit we use the voltage on analog pin 0 will not range from
0 to 5 volts but instead between two lesser values (these
values will change based on your setup). To fix this play with
the val = map(val, 0, 1023, 0, 179); line. For hints on what to
do visit http://arduino.cc/en/Reference/Map .

mORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC09

-




CIRC-10 ..Temperature:.

.:TMP36 Precision Temperature Sensor:.

( WHAT WE'RE DOING:

What's the next phenomena we will measure with our
Arduino? Temperature. To do this we'll use a rather k

complicated IC (integrated circuit) hidden in a package
identical to our P2N2222AG transistors. It has three pin's,
ground, signal and +5 volts, and is easy to use. It outputs 10
millivolts per degree centigrade on the signal pin (to allow measuring temperatures below
freezing there is a 500 mV offset eg. 25° C = 750 mV, 0° C = 500mV). To convert this from the
digital value to degrees, we will use some of the Arduino's math abilities. Then to display it
we'll use one of the IDE's rather powerful features, the debug window. We'll output the value
over a serial connection to display on the screen. Let's get to it.

One extra note, this circuit uses the Arduino IDE's serial monitor. To open this, first upload the
program then click the button which looks like a square with an antennae.

The TMP36 Datasheet:
Qttp://ardx.org/TMP%

ﬁ' HE CIRCUIT: \
( Parts:

CIRC-10
Breadboard Sheet
x1

TMP36

Temperature Sensor Wire
R 7N
( Schematic \

Arduino
analog +5 volts

pin 0

2 Pin Header
é x4

N the chip will have
TMP36 printed
on it

A~ TMP36
signal (precision
nd. temperature

sensor)

—L gnd

\ —  (ground) ()
/ The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS10S
sview:.
assembly video
http://ardx.org/VIDE10

N

\S




(c

ODE (no need to type everything in just click)

(copy the text and paste it into an empty Arduino Sketch)

Arduino Experimentation Kit Example Code |
CIRC-10 .: Temperature :.

A simple program to output the current temperature
* to the IDE's debug window
* For more details on this circuit:

//TMP36 Pin variables
int temperaturePin = 0;//the analog pin the TMP36's
//vout pin is connected to

//the resolution is

//10 mv / degree centigrade
//(500 mv offset) to make
//negative temperatures an

option

void setup()
Serial.begin(9600); //Start the serial connection

/with the computer

//to view the result open the

//serial monitor

//last button beneath the file

//bar (looks 1ike a box with an

//antenna)

}

-

Download the Code from ( http://ardx.org/CODE10 )

void loop()
// run over and over again

float temperature = getvoltage(temperaturePin);
//getting the voltage reading from the
//temperature sensor

temperature = (temperature - .5) * 100;//converting from 10
mv
//per degree wit 500 mv offset to
//degrees ((volatge - 500mv) times
100)

serial.printin(temperature); //printing the result
delay (1000 ; //waiting a second
}

* getvoltage() - returns the voltage on the analog input
* defined by pin

*/
float getvoltage(int pin){
return (analogRead(pin) * .004882814);//converting from a 0
//to 1024 digital range
// to 0 to 5 volts
//(each 1 reading equals ~ 5
millivolts

J

[NOT WORKING? (3 things to try)

“\\

indication it is working. To see
the results you must open the
Arduino IDE's serial monitor.

different speed than expected.
To fix this, click the pull-down
box that reads "*** baud" and

a N\ a N\ { N
Nothing Seems to Happen Tﬁ.'ﬁ]ber'Sht: s Dlsp;ayeql Temperature Value is
This program has no outward is happens because the seria .

monitor is receiving data at a Unchanging

Try pinching the sensor with
your fingers to heat it up or
pressing a bag of ice against it

(instructions on previous page)

change it to "9600 baud".

to cool it down.

N\ A

2/

[MAKING IT BETTER

Outputting voltage:

This is a simple matter of changing one line. Our
sensor outputs 10mv per degree centigrade so to get
voltage we simply display the result of getVoltage().

delete the line  temperature = (temperature - .5) * 100;

Outputting degrees Fahrenheit:
Again this is a simple change requiring only math. To
go degrees C ----> degrees F we use the formula:
(F=C*18)+ 32)
add the line
temperature =
(((temperature - .5) * 100)*1.8) + 32;
before Serial.printin(temperature);

More informative output:
Let's add a message to the serial output to make what

\is appearing in the Serial Monitor more informative. To

~

do this first revert to the original code then change:
Serial.printin(temperature);
>

Serial.print(temperature);
serial.printin(" degrees centigrade");

The change to the first line means when we next output it
will appear on the same line, then we add the informative

text and a new line.
Changing the serial speed:
If you ever wish to output a lot of data over the serial line

time is of the essence. We are currently transmitting at 9600
baud but much faster speeds are possible. To change this

change the line:
Serial.begin(9600); ----> Serial.begin(115200);
Upload the sketch turn on the serial monitor, then change

the speed from 9600 baud to 115200 baud in the pull down
menu. You are now transmitting data 12 times faster.

J

mORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC10

-




.:Larger Loads:.
.:Relays:.

("WHAT WE'RE DOING:

This next circuit is a bit of a test. We combine what we learned
about using transistors in CIRC03 to control a relay. A relay is
an electrically controlled mechanical switch. Inside the little
plastic box is an electromagnet that, when energized, causes a
switch to trip (often with a very satisfying clicking sound). You can buy relays that vary in size
from a quarter of the size of the one in this kit up to as big as a fridge, each capable of
switching a certain amount of current. They are immensely fun because there is an element of
the physical to them. While all the silicon we've played with to this point is fun sometimes, you
may just want to wire up a hundred switches to control something magnificent. Relays give you
the ability to dream it up then control it with your Arduino. Now to using today's technology to

\control the past. (The 1N4001 diode is acting as a flyback diode, for details on why it's there visit: http://ardx.org/4001) )
/" THE CIrcurT: )

Parts:
& CIRC-11 P Diode Transistor Relay
7 Breadvoardsheet  (* (1N4001) P2N2222AG (T092) ‘ (sPDT)
T ox1 x1 x1 x1
10k Ohm Resistor 330 Ohm Resistor
(ﬂ Brown-Black-Orange F] Orange-Orange-Brown fﬁ Yellow LED * Red LED
x1 x2 r x1 x1

“ 2 Pin Header
x4

/ Schematic \

Arduino
pin 2

resistor
(10kohm)
Transistor
the transistor will have
P2N2222AG printed on it

(some variations will have
the pin assignment reversed)

-
\ gnd /
(ground) (- —
( The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS11S
view:.
assembly video
http://ardx.org/VIDE11

-

=




@0DE (no need to type everything in just click)

File > Sketchbook > Digital > Blink
(example from the great arduino.cc site, check it out for other great ideas)
/ak

* Blink

The basic Arduino example. Turns on an LED on for one second,
then off for one second, and so on... We use pin 13 because,
depending on your Arduino board, it has either a built-in LED
or a built-in resistor so that you need only an LED.

http://www.arduino.cc/en/Tutorial/Blink

int ledpPin = 2; // ¥ CHANGE TO PIN 2 *%
void setup() // run once, when the sketch starts
pinMode(TedPin, OUTPUT); // sets the digital pin as output
void loop() // run over and over again
di?ita1write(1edPin, HIGH); // sets the LED on
deTay(1000); // waits for a second
digita1write(1edPin, LowW) ; // sets the LED off
deTay(1000); // waits for a second

\_

J

\

[NOT WORKING? (3 things to try)

{ 3 3
i Not Quite Working
Nothing Happens No Clicking Sound The included relays are
The example code uses pin 13 '
and WF; have the relz The transistor or coil portion of designed to be soldered rather
connected to pin 2 Makeysure the circuit isn't quite working. than used in a breadboard. As
q th'p h o th Check the transistor is plugged such you may need to press it
you maae this change in the in the right way. in to ensure it works (and it
code. .
may pop out occasionally).

N\ ) a 7

[MAKING IT BETTER

Watch the Back-EMF Pulse
Replace the diode with an LED. You'll see it blink each time it “snubs” the coil voltage spike when it turns off.

Controlling a Motor
In CIRC-03 we controlled a motor using a transistor. However if you want to control a larger motor a relay is a good option.

To do this simply remove the red LED, and connect the motor in its place (remember to bypass the 330 Ohm resistor).

-

~

mORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

\\ http://ardx.org/CIRC11




.:Colorful Light:.
.:RGB LEDs:.

('WHAT WE'RE DOING:
When you first started with CIRCO1 you were happy just to
get a red LED blinking away. But you're past that now,
right? You want orange, you want teal, you want aubergine!
Fortunately there's a way to shine multiple colors from a single
LED without having to stock up on every shade of the rainbow. To do this we use a RGB
LED. An RGB LED isn't a single LED it's actually three LEDs in one small package: one
Red, one Green and one Blue. When you turn them on their light mixes together and you
get other colors. The color you get is a result of the intensity of the individual red, green
and blue LEDs. We control the intensity with Pulse Width Modulation (PWM) which we've
used before to control LED brightness and motor speed.

.

J
ﬁ HE CIRCUIT: \
ﬂ’arts:

CIRC-12 i 5mm RGB LED
<.~ Breadboard Sheet ¢ )2(4P|n Header % x1 /\ Wire
- x1

330 Ohm Resistor
( H Orange-Orange-Brown
k x3

/ Schematic  § \
Arduino 3
pin1l  pin10 pin9 ]
85c
=5 0=
8256
longest flat_=
lead Y~ side

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS12




@0DE (no need to type everything in just click)

Download the Code from (http://ardx.org/CODE12S)
(copy the text and paste it into an empty Arduino Sketch)

/*Cycles through the colors of a RGB LED*/
// cycle color from green through to blue

// LED leads connected to PWM pins for (blueIntensity =

const int RED_LED_PIN = 9; blueIntensity <= 255

const int GREEN_LED_PIN = 10; blueIntensity+=5) {

const int BLUE_LED_PIN = 11; greenIntensity = 255-blueIntensity;

analogwrite(BLUE_LED_PIN, blueIntensity);
analogwrite (GREEN_LED_| PIN, greenIntensity);
delay(DISPLAY_TIME);

// Used to store the current intensity level
int redIntensity = 0;

int greenIntensity = 0;

int blueIntensity = 0;

// Length of time showing each color // Cycle cycle from blue through to red
const int DISPLAY_TIME = 100; // milliseconds for (redintensity = 0;
redIntensity <= 255;
void setup(Q { redIntensity+=5) {
/ No setup required. blueIntensity = 255-redIntensity;

analogwrite(RED_LED_PIN, redIntensity);
analogwrite(BLUE_LED_PIN, blueIntensity);

void ToopO { delay (DISPLAY_TIME);
// Cycle color from red through to green 3}
for (greenIntensity = 0; 1

greenIntensity <= 255
greenIntensity+=5) {

redIntensity = 255-greenIntensity;
analogwrite(GREEN_LED_PIN, greenIntensity);
analogwrite (RED_LED_PIN, redIntens1ty),

\ delay(DISPLAY_TIME); j

[NOT WORKING? 3 things to try) )
a N\ a - N\ { -
LED Remains Dark or Seeing Red Looking For More?
The red diode within the RGB LED
Shows Incorrect Color may be a bit brighter than the - (,Sh"’l'mi'fess tplL('jg)
With the four pins of the LED other two. To make your colors you're looking to do more
o more balanced, use a higher ohm why not check out all the
so close together, it's resistor. Or adjust in code. lovely extra bits and bobs
sometimes easy to misplace analogwrite(RED_LED_PIN, Y 3
) redIntensity); available from
one. Try double checking each to http://www.SparkFun.com
pin is where it should be. analogwrite (RED_LED_PIN, P =P !

redIntensity/3);

Q J \ J \ Jj
\

[MAKING IT BETTER

Using HTML-style color codes A land of diffusion
If you're familiar with making web pages you One disadvantage of using a RGB LED made up of

might prefer to specify colors using "hex triplets"  three separate LEDs to generate our colors is that
like you do when you use HTML and CSS. A hex sometimes it's possible to see the color of the

triplet specifies a color using a series of letters individual lights. One way to workaround this is to find
and numbers like " #FF0000" for red or a way to make the light more diffuse (or scattered) so

" #800080° for purple. You can learn more about  that the individual colors mix together better. The LED
how this works on Wikipedia supplied with your kit is diffused rather than clear to
(http://ardx.org/HEXCOL) and find a list of help improve the effectiveness of the color mixing. If
colors with their associated hex triplets so you the light still isn't diffuse enough you can try putting
don't need to work it out yourself. the LED behind some paper or acrylic; or inside a ping
Download the code from: pong ball or polystyrene ball.

\ http://ardx.org/RGBMB j

mORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

\\ http://sparkfun.com/RGB




.:Measuring Bends:. \
.:Flex Sensor:.

(WHAT WE'RE DOING:
In life it's important to be flexible. But what do you do
if you want to measure how flexible an object is? You \
use a flex sensor. A flex sensor uses carbon on a strip '
of plastic to act like a variable resistor or potentiometer
(CIRC-08) but instead of changing the resistance by turning a knob you change it
by flexing (bending) the component. We use a "voltage divider" again (CIRC-08 &
09) to detect this change in resistance. The sensor bends in one direction and the
more it bends the higher the resistance gets--it has a range from about 10K ohm
to 35K ohm. In this circuit we will use the amount of bend of the flex sensor to

Qontrol the position of a servo.

J
ﬁ HE CIRCUIT: \

ﬁ’a rts:
s CIRC-13 i Flex Sensor
v//g(”" Breadboard Sheet & )2(4P|n Header / x1 /\ Wire

x1

= . 10k Ohm Resistor
Mini Servo & 3:'" Header (ﬂ Brown-Black-Orange
k x1 . x1

7~ Schematic

pin 9

Mini Servo signal

flex
E sensor

analog
pin 0

gnd
(black)

gnd——

K (ground) (-) = j

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS13S




@0DE (no need to type everything in just click)

Download the Code from (http://ardx.org/CODE13S)
(copy the text and paste it into an empty Arduino Sketch)

// Based on }
// File > Examples > Servo > Knob
// Controlling a servo position using a
// potentiometer (variable resistor)
// by Michal Rinott // val = ana]ogR;ad(gotﬁin);// reads the value
<http://people.interaction- of the potentiometer
ivrez {{?m ?1nott> //(value between 0 and 1023)
. . Serial.println(val);
val = map(val, 350, 550, 0, 179);
// scale it to use it with the servo
// (value between 0 and 180)
myservo.write(val); // sets the servo
// according to the
// scaled value

goid Toop(Q)

#include <Servo.h>
Servo myservo; // create servo object to
// control a servo

int potpin = 0; // analog pin used to
// connect the

// potentiometer

// variable to read the 1
//value from the analog pin

delay(15); // waits for the servo

int val; // to get there

void setup()

Serial.begin(9600);
myservo.attach(9);// attaches the servo
\\> // servo on pin 9 to the servo object

[NOT WORKING? (3 things to try)

{ 3

[ Servo Not Moving As

Expected Servo Moves Once

Servo Not Twisting?
Even with colored wires it is
still shockingly easy to plug a
servo in backwards. This might
be the case.

The sensor is only designed
to work in one direction. Try
flexing it the other way.
(where the striped side faces

You may need to modify the
range of values in the call to

the map() function
(details in the making it better

in on a convex curve) section below)

Q J \\ J \

2/
~N

[MAKING IT BETTER

Calibrating the Range 550) value with the fully bent value.

While the servo is now moving chances are its
range isn't quite perfect. To adjust the range we
need to change the values in the map () function.

map(value, fromLow, fromHigh,
toLow, toHigh)

Applications
With sensors the real fun comes in using them in neat
and un-expected ways here are a few of our favorite
flex sensor applications.

One Player Rock Paper Scissors Glove

A glove that lets you play RPS against yourself.
http://ardx.org/RPS

For full details on how it works:
http://ardx.org/MAP

To calibrate our sensor we can use the debug

window (like in CIRC-11). Open the debug

window then replace the fromLow value (default

350) with the value displayed when the sensor is

\un bent. Then replace the fromHigh (default

Electronic Plant Brace
Monitor if your plant is bending towards light
and fix it.
http://ardg.org/BRACE

mORE, MORE, MORE:
More details, where to buy more parts, where to ask more questions:

http://sparkfun.com/




.:Fancy Sensing:. \

.:Soft Potentiometer:.

(WHAT WE'RE DOING:
A "soft pot" (short for "soft potentiometer") is like a

regular potentiometer of the style seen in CIRC-08

except, it's flat, really thin, flexible and doesn't have a

knob. A potentiometer is also known as a "variable
resistor" and for a soft pot the resistance it provides is determined by where
pressure is applied. Pressure can be applied with your finger, a stylus or a hard
plastic "wiper". By pressing down on various parts of the strip, the resistance
varies from 100 to 10k Ohms allowing you to calculate the relative position on the
strip. You can use this to track movement on the softpot or discrete "button style"
Qresses. In this circuit we'll use it to control the color of an RGB LED.

/" THE CIrCUIT: N\
ﬁ’a rts:
s CIRC-14 .
& 1 2 Pin Header 5mm RGB LED
M/‘*" Breadboard Sheet & % 1 Wire
. o x1 x4 X /\
Soft Potentiometer 330 Ohm Resistor
k Orange-Orange-Brown
x1 3
7~ Schematic N\

Arduino
pinil  pinl0 pin9

+5 volts

resistorg Arduino
(3300hm) ¥ soft-pot analog
pin 2
g 5 L
g N wiperT—
RVARVA? [&
gnd|
\angejﬂ‘
lead
‘—e gnd

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS14S
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@0DE (no need to type everything in just click)

// CIRC-14 Example Code
// Will fade an RGB LED from Red-Green-Blue
// in relation to the soft pot value

// LED Teads connected to PWM pins

const int RED_LED_PIN = 9; //Red LED Pin
const int GREEN_LED_PIN = 10; //Green LED Pin
const int BLUE_LED_PIN = 11; //Blue LED Pin

void setup() {
//no need for any code here

void Toop() {
int sensorvalue = analogRead(0);
//read the soft Pot

int redvalue = constrain(

map(sensorvalue, 0, 512, 255, 0),0,255);
//calculate the red value (255-0
//over the range 0-512)

-

Download the Code from (http://ardx.org/CODE14S)
(copy the text and paste it into an empty Arduino Sketch)

// Display the requested color

int greenvalue = constrain(
map(sensorvalue, 0, 512, 0, 255),0,255)-
constrain(

map(sensorvalue, 512, 1023, 0, 255),0,255);
//calculate the green value (0-255
//over 0-512 & 255-0 over 512-1023)

int bluevalue = constrain(

map(sensorvalue, 512, 1023, 0, 255),0,255);
//calculate the blue value 0-255 over
//512-1023

analogwrite(RED_LED_PIN, redvalue);
analogwrite(GREEN_LED_PIN, greenvalue);
analogwrite(BLUE_LED_PIN, bluevalue);

J

\

[NOT WORKING? (3 things to try)

{ 3
LED Remains Dark or
Shows Incorrect Color
With the four pins of the LED
so close together, it's
sometimes easy to misplace
one. Try double checking each
pin is where it should be.

Seeing Red
The red diode within the RGB LED
may be a bit brighter than the
other two. To make your colors
more balanced, use a higher ohm
resistor. Or adjust in code.
analogwrite(RED_LED_PIN,
redvalue);

analogwrite(RED_LED_PIN,
redvalue/3);

~\

Bizarre Results
The most likely cause of this is
if you're pressing the
potentiometer in more than
one position. This is normal
and can actually be used to
create some neat results.

to

N\ A

L )

[MAKING IT BETTER

HSB Color (Hue, Saturation & Brightness)
Our RGB LED displays colors using RGB color

codes. However this is often not the easiest way
of working with colors (as noted by the less than
reader friendly code above). A much more
intuitive system is HSB.
Full Details:
http://ardx.org/HSB

To convert from RGB to HSB all that is required is
some slightly complicated math. For an example
program visit:

http://ardx.org/CODE14MB
based on www.kasperkamperman.com's original

\code: http://ardx.org/KASP

~

Now when you use the soft pot you'll notice a much
cleaner and fuller fade from red through to violet.

Faux Buttons
Because of the way the soft pot works it can also be
used to make custom buttons. To do this you define a
range of values corresponding to a discrete button.
Use the code snippet below and the debug window to
determine desired values.
if(analogRead(0) > minvalue &&
analogRead(0) < maxvalue){
buttonAction()
Then cover the soft pot with a drawn/printed button
pattern
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mORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://sparkfun.com/
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